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Introduction

Welcome to the HEC-ResSim Quick Start Guide. This document will take
you through the steps needed to develop a reservoir simulation model
using HEC-ResSim. Use this document to get a quick overview of the
program and its basic features. For more detailed information, refer to the
HEC-ResSim User’s Manual /references to the HEC-ResSim User's Manual
are given in this type of formatted text to provide you with a cross
reference for locating additional information]. “New” features (from
Version 2.0 to Version 3.0) are indicated as highlighted text.

Starting the Program

Once HEC-ResSim has been installed on your PC, start the program as
follows:

From Microsoft Windows -

On your desktop, double-click on the HEC-ResSim icon
or, from the Start menu, select All Programs — HEC
— HEC-ResSim - HEC-ResSim 3.0.

When you first start the program,
you will see an introductory HEC-ResSim

screen containing the version

and contact information. This Version 3.0

screen will disappear after a few April 2007
moments. However, the same

information is available from Hydrologic Engineering Center
ResSim’s Help menu by Institute for Water Resources

US Army Corps of Engineers
609 Second Street

Davis, CA 95616

U3 Army Corps ;
of Engineers www . hec.usace.army.mil

selecting the About option.

Exiting the Program

To exit the program, from the File menu on the Main Window, select
Exit. The program will prompt you to save all files.

April 2007 1
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First, Some Terminology...

What is a Watershed?

In HEC-ResSim terminology, a Watershed is a collection of data
associated with a particular reservoir system or study /Chapter 3] Types of
data include Watershed Setup (Configurations) /Chapter 7], Reservoir
Networks (including Operation Sets /Chapter 11]and Alternatives /Chapter
13)), and Simulations /Chapter 14]. After performing a Simulation, which
will include one or more Alternatives, you can view and print results in
both tabular and graphical form /Sections 14.5 & 14.8 and Appendices E & F.
This guide provides basic steps for using the Graphical User Interface
(GUI) to enter data, run simulations and view results.

What are Watershed Locations?

A Watershed Location is the place on disk where you can store
watersheds; also called a working directory (Section 3.3.1). You can have
multiple watershed locations, although a given watershed cannot span
multiple locations. Each watershed location should be given a descriptive
name, such as My Watersheds or General Projects, and a path
specification that identifies the directory “on disk” where you want to
create and edit your watershed data.

X HEC-ResSim 3.0 Options x]

Model Directories | Cache Directary| Caompute Display| Debug Levels | General | Fonts
Watershed Locations

MName Location

[ Add Location .. ] [ Remove Location ] [ Edit Location .. ]

[ ok [ cancel |

Figure 1 — Tools Menu, Options Editor, Watershed Locations

Before you can create or open a watershed, you must define at least one
watershed location. Do so by selecting Options from the Tools menu.
The Options Editor will appear as shown in Figure 1. The first tab of the
Options editor is used to define Watershed Locations. To add a new
location to the list, press the Add Location... button. The Add
Watershed Location screen will appear (Figure 2). In the Location field,

Add Watershed Location

Mame:

Location: Browse ...

’ Ok ” Cancel l

Figure 2 — Add Watershed Location
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you can enter the full path to the working directory or you can Browse to
the area on disk where you want to build your watershed (this working
directory will be the “holder” of a sub-directory named “base”). Next,
enter the name you are giving this location in the Name field and press
OK.

What are Modules?

The ResSim program is divided into separate sets of functions called
modules /Chapters 1 and 2]. Each module provides access to specific
types and directories of data within the watershed data tree /Appendix A].
The three modules within the ResSim program are:

o Watershed Setup /Sections 1.1 & 2.3 and Chapters 3 through 7]
e Reservoir Network /Sections 1.2 & 2.4 and Chapters 8 through 13]
e Simulation /Sections 1.3 & 2.5 and Chapter 14]

Figure 3 provides a graphical illustration of the three modules that make

up HEC-ResSim. Refer back to this figure as you learn more about the
function of each module to help keep the concepts organized.

Watershed Setup

Configurations

Projects
(Reservoirs, Diversions, Levees, etc.

Computatiaon Points

Reservoir Network

Networks Alternatives

Reservoirs Selection of

* Pool o - Network

- Outlets oo

+ Operation Sets - Operation Set
. lres - Initial Conditions

sl + Time Series Data
Diversions

Junctions

Simulation

Simulations

Time Window
Selected Alternatives

Figure 3 — ResSim Module Concepts
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Watershed Setup Module

The opening window of the Watershed Setup Module is shown in Figure
4. As you can see, most menus and tools are inactive (greyed-out). They
will remain so until a watershed is created or opened, which can be done
by selecting New Watershed or Open Watershed from the File menu
in the Watershed Setup Module. When a watershed is created, ResSim
constructs a directory tree where all files pertaining to the watershed will
be stored. Those files specific to the ResSim model (and not shared by
other models) are stored in the watershed directory tree in a subdirectory
named IsS.

X HEC-ResSim 3.0
rahied t Tools Help

o [ BAENEk (e EHex ¢

< >

| Reacy |messapes —
Figure 4 — Watershed Setup Module, Opening Window
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The Watershed Setup Module main window has the following menus:

File

Edit

View

Watershed

Reports

Tools

Help

This menu will appear in all modules and most
editors. In the main window, it always includes
the options Open Watershed, Save
Watershed, Save Map As, and Exit. In the
Watershed Setup Module, the option New is
also included. These options relate to the
overall watershed data.

This menu will appear in all modules and most
editors. This menu is module specific. The edit
options will be relevant to data elements
currently available for modification.

View options relate to all modules. Options
include adding Layers that are displayed in
the map region and defining the Unit System
for viewing.

This menu is only available in the Watershed
Setup Module. Watershed options relate to the
entire watershed, as well as to the individual
configurations and the stream alignment.
Options include Configuration Editor,
Update Computation Points, Import and
Export (of Stream Alignment), and Save
Configuration.

Predefined reports and tables are listed in this
menu. This menu appears in all modules, but
its content is module specific. In the
Watershed Setup and Reservoir Network
Modules, most of the reports detail input data.
In the Simulation Module, the reports detail
simulation results.

User setting options, properties, and extended
tools such as HEC-DSSVue and scripting are
found here.

On-line help is not yet available. This option
currently displays version information. This
option also provides for accessing user
documentation and for the installation of
example watersheds -- after defining a
watershed location (Section 3.3.1).
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Figure 5 shows the main window of the Watershed Setup Module after
opening an existing watershed (HayesBasin). A map region occupies the
majority of this window, where the user must place the project elements
(e.g., reservoirs) onto the stream alignment (all configurations that will be
defined for this watershed will be on this alignment). A background map
can be added (but is not required) to the map region to help identify the
streams for the alignment.

. HEC ResSim 3.0 - HayesBasin
File Edit ‘Wiew ‘Wwatershed Reports Tools Help

Module: [Watershed Setup v Configuration [StandardConfig @
NS

[0 2 BAENEP #HF (o] (Bo=

< >

Reatly Local Workspace HayesBasin opened =
\ J =

Figure 5 — Watershed Setup Module, Opened Watershed, HayesBasin
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Reservoir Network Module

The Reservoir Network Module is used for editing element (e.g.,
reservoir, computation point, and routing reach) data and placing
additional elements onto the stream alignment. Figure 6 shows an
example of the Reservoir Network Module window for HayesBasin. This
example shows a Network named “NormalNetwork2” which was created
by selecting New from the Network menu and selecting
“StandardConfig” from the Configuration list. A map region occupies the
majority of this window, where the user must place Routing Reaches
(required for connectivity) and Diverted Outlets (if appropriate) onto the
stream alignment.

X HEC-ResSim 3.0 - HayesBasin =153
File Edit View Mebwork Alternative Reports Tools Help

Module: -Reaenmir Metwork v/ Metwork:  Mormaltetwork? 1 Configuration: .Slamdardonmﬁg

NS

Gl NI GO

<

:Ready V;\,pte]\qukSpa;gHayESEaSlﬂ opened Z[:]

Figure 6 — Reservoir Network Module, HayesBasin

You edit element data within the Reservoir Network Module. First, select
the appropriate tool from the tool bar on the left side of the window, then
right-click on the element. A shortcut menu appears with options to edit
data defining the element. Alternatively, select the general pointer tool
from the top of the toolbar on the left side and right-click on any element
to view the shortcut menu.
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The menus that are new or unique to the Reservoir Network Module are

listed and described below:

Edit

Network

Alternative

Reports

This menu will appear in all modules and most
editors. The edit options available for reservoir
networks include: Reservoirs, Reaches,
Junctions, Diversions, and Reservoir
Systems, State Variables, Import
Elements, and Allow Network Editing.

Network options are used in defining the
network and configuration to be used. Options
include New, Open, Save, Save As, and
Rename. Also included are the Update
Network from Configuration and Delete
Networks options.

The only option in this menu is Edit. This
opens the Alternative Editor, which will enable
you to create, edit, and save alternatives.

Predefined reports and tables are listed in this
menu. Options include Reservoir List,
Reach List, Junction List, and Diversion
List. An Advanced option is also available
that shows a summary table of the Network
elements and their connectivity, as well as a
listing of Nodes in the network.
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Simulation Module

The Simulation Module is designed to facilitate the analysis phase of
reservoir modeling. In this module you will create and run Simulations.
Each Simulation is a specification of the time window and Alternatives
that you want to analyze.

A view of the Simulation Module is shown in Figure 7. This view shows
an open Simulation (200ct1999-0600) with one of the Alternatives
(StandNorm?2) of the Simulation set as active (bolded alternative).

. HEC ResSim 3.0 - HayesBasin E”E\@

File Edit ‘Wiew Simulation Alernative Reports Tools Help

Madule:
L’ Simulation Control

Simulation: 20 Oct 1999, 0600
Lookback: 18 Oct 1999, 0200
End: 21 Oct 1944, 2100

_4 200c41998-0600
StandNorm2
Alt2 %

Compute Standnorm2

Scripts

Reatly Local Workspace HayesBasin opened =
\ J =

Figure 7 — Simulation Module, HayesBasin
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The menus that are new or unique to the Simulation Module are listed
and described below:

Edit This menu will appear in all modules and most
editors. The edit options available for the
Simulation Module include: Script List
selection, Set Active Alternative, and
editors for Reservoirs, Reaches,
Junctions, Diversions, Reservoir
Systems and State Variables.

Simulation Simulation options are provided for creating,
opening, saving, and editing simulations.
Options include New, Open, Re-Open,
Close, Edit, Save, Delete, and Info. Also,
Release Overrides can be defined from this
menu.

Alternative The only option in this menu is Edit. This
opens the Alternative Editor, which will enable
you to edit and save alternatives.

Reports Predefined reports and tables are listed in this
menu. Options include Reservoir Summary,
Flow Summary, Power Summary, Gates
Summary, Stage Summary and Release
Decision report. Also available from this
menu are User Reports and Compute
reports and Network Element Lists
(Reservoir, Reach, Junction, and
Diversion, as well as the Advanced
Network Summary).
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Getting Down to Business...

The basic steps for developing a reservoir model are outlined below.
These steps are illustrated in the sections that follow.

Steps in Developing a Reservoir Model
A ResSim application entails the following steps:

o Set Up the Watershed

e Create/Open a Watershed /Section 3.3]

e Add Map files [Section 3.4 and Chapter 4 and Appendix C]
e Draw a Stream Alignment /Chapter 5]

e Create a Configuration /Chapter 7]

¢ Place Project Elements into the Configuration /Chapter 6]

o Develop a Reservoir Network

e Create/Open a Network /Section 8.2]
e Add Routing Reaches /Section 8.4]
e Edit Junction Properties /Section 9.1]
e Edit Reach Properties /Section 9.2]
¢ Edit Reservoir Properties
» Physical Data /Chapter 10]
» Operations Data /Chapters 11 and 12]
» Observed Data /Sections 10.21 and 13.8]

a Define Alternatives

e Create an Alternative [Sections 13.2 and 13.3]

e Select the Operation Scheme(s) /Section 13.4]

¢ Specify Lookback Conditions /Section 13.6]

e Identify Time-Series data records from DSS /Sections 13.7 and 13.8]

a Perform a Simulation

e Create/Open a Simulation /Sections 14.2 and 14.3]

e Select/Activate Alternatives /Section 14.4.1]

e Compute /Section 14.4.2]

e View Results /Sections 14.5 & 14.8 and Appendices E & F]
e Specify Overrides /Section 14.6.3]

e Manage Simulation Data /Section 14.7]

April 2007 11
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Set Up the Watershed

1. Create/Open a Watershed. In the Watershed Setup Module,
choose New Watershed from File menu. The new watershed screen
will appear, as illustrated in Figure 8. Enter a name for your watershed
and a detailed description in the appropriate fields. From the
Location list, select where you want your watershed stored. If the
Location list is empty, press Cancel, and go back to page 2 to see

how to add a _
Watershed Location. Crpate New Waterehed X
Use the Units list to Marne:

select the unit system Destription: Q
that the watershed Lacation: |y Watersheds v
will use when storing Units: 3
its data. The available [ Tirne Zones... ]
unit systems are [ ok ][ camal |
English and SI

(i.e., US Customary Figure 8 — New Watershed

and International System of Units). Then selecta Time Zone. The
watershed time zone is always specified as some offset from GMT,
which does NOT recognize Daylight Savings Time. When you have
completed all fields, press OK /Section 3.3].

2. Add a Map. When a watershed is created, ResSim constructs a whole
directory tree. One of the subdirectories in the watershed tree is the
maps directory. Using a file system viewer (like Windows Explorer),
copy the files you will use as background maps into the maps directory
of your watershed:

<watershed location>\base\<watershed name>\maps

= HayesBasin - Layer Selector g@g|

Lavers [LI Maps iew The supported types of map files include DLG (USGS
Al Digital Line Graphs), SHP (ArcView® shapefiles),

E DXF (Autocad® Digital Exchange Format), DEM

G (USGS Digital Elevation Models), IMG (Raster

© at Tockar uton . Image), ASC (ArcInfo® ASCII grid), and NET (ASCII

Reload Default Button

NetTIN) /Appendix C].

Allow Layer Editing

To display a map in the watershed, go to View,
Layers... This will open the Layers Editor. First,
make the layers editable by selecting Allow Layer
Editing from the Edit menu. This is illustrated in
Figure 9. Then, from the Maps menu, select Add

Map Layer. This will open another window frpm
which you can select the map file you want to view.

Figure 9 — Allow Layer
Editing
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Note that it is not necessary to display a map. However, it is
convenient to have the map as a guide when creating stream
alignments /Section 3.4 and Chapter 4].

e Zoom. To zoom in or out on the map area, select the zoom tool

@ on the left side of the window. To zoom in, click and drag
over the desired viewing area. To zoom out, right-click until the
desired viewing area is visible. Alternately, to zoom out to the
original display, go to View, Zoom to All.

3. Draw a Stream Alignment. The next step is to create a stream
alignment on which stream reaches and reservoirs can later be located
[Chapter 5]. First, ensure that you are working in the Watershed Setup
Module. If you aren’t, then be sure to select Watershed Setup from
the Module list. Second, from the Edit menu, activate Allow
Editing (a check mark will appear to the left and the “yellow lock” in
the upper right portion of the window will lock to indicate that you are

in the edit mode). Alternately, the yellow lock @ can be pressed to
allow editing.

R HECResSim 3.0 -Demo
File Edit Wiew ‘Watershed Reports Tools Help

R ——
Module !Walershed Setup "1\ Configuration ;_Sludy

| Ready |Lacal Wiorkspace Demo opened

Figure 10 — Drawing a Stream Alignment
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Create a Stream Alignment Element. The Stream Alignment
must be created from upstream to downstream. Select the stream

alignment tool il from the tool bar along the left side of the map
region. Hold down the control (CTRL) key and click to place
successive points along the stream alignment. To terminate the
stream element, release the CTRL key and click to place the last
point of the stream. As shown in Figure 10, a tributary may be
connected to a stream by following the same procedure as above
and terminating the stream at the point of connection to the
existing stream.

Edit a Stream Element. Select the stream alignment tool il
and double click on the stream element to be edited. The stream
will change color, and nodes will appear where each stream point
was originally defined. These element points can be moved to
realign the stream by positioning the cursor over them and holding
down the left mouse button and dragging. New points are added to
a stream by clicking on the stream while holding down the CTRL
key. Remove points from a stream by clicking over an existing
point while holding down both the SHIFT and CTRL keys. An
entire stream can be deleted by right-clicking on it and selecting
Delete Stream Element from the shortcut menu. Streams can
be renamed by right-clicking on the stream and selecting Rename
Stream Element.

Define Stationing. The green dots at the end of each stream in the
alignment are Stream Nodes. Their purpose is to define the
stationing along the stream. By default, the most downstream
node will get a stream station of zero, and the node at the upstream
end will get a stream station value determined by the length of the
stream line in the coordinate system of the map region. However,
these default values can be changed to more accurately describe

the stream. Using the stream node tool i right-click on a stream
node and select Edit Node. In the editor that appears, uncheck
the “Use Default Stationing” box then update the value of the
station to represent the appropriate real world station value of that
representative point. If you change the stationing of the upstream
node, then you may need to edit the most downstream node to reset
its station to zero (0.0). Stationing along a stream will be
determined proportionally based on the station values of the
bounding nodes. Interior stream nodes can be added to a stream to
more accurately define distances along a stream and to locate
known river station landmarks. To do so, select the stream node
tool, then while holding down the CTRL key, click those locations
on a stream where you want to place a stream node.

14
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4. Create a Configuration. Before adding reservoirs and computation
points, a Configuration must be defined /Chapter 7] In brief, a
Configuration is the identification of a “set” of projects that you want
to model in your watershed. If more than one set of projects will be
considered in a study, then more than one Configuration will be
needed. While you add projects to your Configurations, a special
“superset” (named Study) is developed by the program to contain all
projects from all Configurations in the watershed. If multiple
programs (e.g., HEC-HMS, HEC-FIA, HEC-RAS, etc) are going to be
applied to your watershed, then Configurations should be developed by
the whole modeling team before the models for an individual program

are produced.

e Make the Configuration Editable. Before you can create or
modify a Configuration, you must make it editable. To do so,
select Allow Editing from the Edit menu %click the

“unlocked” @ yellow lock, which “locks”

the configuration

(allowing you to perform editing). In other words, this option
turns on (or off) the ability to make changes to the Configuration.

e Create the Configuration. From the Watershed menu, select
Configuration Editor. From the Configuration menu in the
Configuration Editor that has opened (Figure 11), select New. In

the new configuration
window, enter a Name
and Description for the
Configuration and select a
time step from the Time
Step list and press OK.
Then, click OK in the
Configuration Editor.

? Configuration Editor @

Configuration Edit  Projects
MName: % w

Description: [
Base Date: o

Time Step:

Projects

Project
Mame

Project
Froject Motes Type Existing

Cancel

Figure 11 — Configuration Editor
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5. Place Project Elements into the Configuration. The next step
is to place projects into the watershed /Chapter 6] The projects you
place will be added to the current Configuration as identified in the
Configuration field at the top of the window.

Draw Project Elements. Verify that you have selected the
appropriate configuration to which you will be adding projects.
Select the appropriate tool to add projects. Each project, when
placed, will create one or more computation points. When using

the reservoir tool Q to place reservoirs, hold down the CTRL
key to place the upstream point(s) of the reservoir, then release the
CTRL key and place the downstream point. A Name New
Reservoir window will appear so that you can name the reservoir.

Another useful tool is the computation point !I Use this tool to
place additional computation points by holding down the CTRL
key and clicking on additional locations as needed. As you place
additional computation points, you will be prompted to name them
(when placed at the junction of two or more streams, you will need
to select which stream the computation point should be placed on).
Placing reservoirs on the stream alignment also creates
computation points at the upstream and downstream extents of the
reservoir using automatically generated names. Be sure to rename
each of these points so it can be easily identified from a list when
the map region is not visible. To do so, right-click on the
computation point, select Rename Computation Point from
the shortcut menu and enter a new name in the window as shown
in Figure 12.

Rename Computation Point [‘S_T<|
Mame: CPy|
Description: % J
[ 0].4 l [ Cancel ]

Figure 12 — Rename Computation Point

16
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Save the Configuration. When you are finished adding
elements to the Configuration, be sure to save it and turn off
editing. Select Save Configuration from the Watershed
menu to save, then “unlock” the Configuration lock (yellow
lock button) to toggle off the editability of the Configuration.
A simple Configuration (named Existing) is shown in

Figure 13.

'R HEC-ResSim 3.0 - Demo
File Edit Wiew Watershed Reports Tools Help

Module: [Watershed Setup v Canfiguration Existing 4|
[ § 3

® & BRNENEM #F (@ =HE

/)

i

<

| Ready Local viarkspace Demo opened =]

Figure 13 — A Simple Configuration, Existing
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Develop a Reservoir Network

With a stream alignment in place and one or more configurations defined, a

network of reservoirs and stream routing reaches can be created. A summary
of the basic steps is presented in the following paragraphs. From the Module
list, select Reservoir Network.

1.

Create/Open a Reservoir
Network. From the Network
menu, select New. The Create
New Reservoir Network window
will appear (Figure 14). Specify a
name and description for the
network. Then, select the
Configuration on which this
network will be based and click
New /Section 8.2].

Reservoirs and computation
points that were part of the
selected configuration will
automatically be created as
elements in the Reservoir

Create New Reservoir Network

\Watershed: Demo

Existing Reservair Netwarks

Mame Cescription

Mesy Reservair MNetwark

]

Description: | O |

Mame:

Configuration: |Existing v|

X]

[ ey h]e[

Cancel l

Figure 14 — Create New Reservoir

Network

Network. Reservoirs transfer directly. Computation points appear as
Junctions. This is depicted in Figure 15.

R HEC-ResSim 3.0 - Demo

File Edit WView MNetwork Alernative Reports Tools Help

Network: | Standard Configuration. | Existing |

EBX

| Ready ELoca\Wurks_p_ggg__@em_u_oggneu

Figure 15 — New Network Based on Configuration Existing
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e Make the Network Editable. Before you can begin editing, you must
ensure the network is editable. To do so, select Allow Network

Editing from the Edit menu (or press the “yellow lock” button @ ).
This option turns on (or off) the ability to make changes to the
network.

2. Add Routing Reaches, etc. Draw the additional elements needed to
complete the connectivity of the reservoir network schematic /Section 8.4].

e Draw Routing Reaches. Select the routing reach tool ﬂ Hold
down the CTRL key and click anywhere on the stream to place the
upstream end of the reach. Release the CTRL key and move the
mouse along the stream and click again at a lower station on the
stream to place the downstream end, as shown in Figure 16. Routing
reaches must be connected to an existing junction. If you start or end a
reach where there is no junction one will be created, and you will be
prompted to first name the new junction and then name the new reach.
Note: tributaries cannot connect to the middle of a reach; they must
connect to a junction.

X HEC-ResSim 3.0 - Demo

File Edit View MNetwork Alernative Reports Tools Help
Module: [Resemvair Network | Network | Standard | [B) connguration: | Edsting
A
_
T “_.
5 2 —n/
e ‘
> Ag\ g k-j/ A
5+ ik A A L v
< | >
| Creating Reach on Stream hiy Main River [I,Upgly\tgrhsgggepgmq opened 7;!:]

Figure 16 — Drawing Routing Reaches
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Edit Junction and Reach Properties. With a reservoir network
schematic complete, the data for the model elements can be entered and
saved.

e Edit Junction Properties. With the pointer tool M or the junction

tool EI selected, right-click on desired junction and select Edit
Junction Properties. The Junction Editor will appear. Select the
Local Flow tab and input a name and factor for each external flow
entering the junction (as shown in Figure 17). The name entered will
appear during the Alternative definition to identify the local flow for
time-series mapping. Therefore, the name given on the Local Flow tab
should be recognizable during the time-series mapping. Flows must be
supplied to headwater junctions and are optional at other junctions.

? Junction Editor @

Mame  MainLocallCT v| (W) zat7[0](m)
Description | J
Info| Local Flow | Rating Curve | Observed Data
Marme Factor
Local Flow for Trik 1.0]
Local helow Dam {an mainstam) 1.0
W
I Ok I [ Apply l [ Cancel

Figure 17 — Junction Editor

To edit junction properties for other junctions without exiting this
window, click Apply and then select another junction from the Name
list or use the navigator buttons located in the upper right portion of
the window. Alternately, click OK, then right-click and Edit another
junction /Section 9.1].

ainkocalict  For each junction where you specify Local Flows, you
SM will see a “halo” around the Junction element. This
provides you with a visual reference for ensuring local

flows have been indicated for the appropriate locations
in your watershed.

20
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e Edit Reach Properties. With the reach tool ﬂ or the pointer tool

M selected, right-click on the desired reach and select Edit Reach
Properties. Select the routing method from the Method list (as
shown in Figure 18) and fill in the necessary parameters for the
selected routing method. The default routing method is Null Routing
(no route).

? Reach Editor @

Reach Mame |myTribOneJCT to MainLocallCT v | [W][a] 1af1 |[m](m]
Description |Rea|:h fram Canfluence with MyTribOne to Junction at a major tributary E]|

| Routing | Losses| Ohserved Data

Method | Coef. Routing i
Mull Routing

Time StEMuskingum

mMuskingum-Cunge 3-pt Channel
mMuskingum-Cunge Prismatic Channel
Modified Puls 0.200
S5ARR Routing
Working RED

]

7

a

q

10

11

0.300
0.500

Figure 18 — Reach Editor

The Coefficient Routing method can be used to model most linear
routing methods by representing the method as a series of coefficients
for each time step of the routing extent. Specifying a coefficient of 1.0
in the first row of the Coefficient table is the same as specifying a null
routing.

To edit another reach without exiting this window, click Apply then
select another reach from the Reach Name list or use the navigator
buttons to select another reach. Alternately, click OK, then right-click
and Edit another reach /Section 9.2].
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4. Edit Reservoir Properties. With the reservoir tool Q or the pointer

tool M selected, right-click on a reservoir, select Edit Reservoir
Properties and the Reservoir Editor window will appear as shown in
Figure 19. This editor has a tab panel with three tabs: Physical tab
[Chapter 10], Operations tab /Chapters 11 and 12], and Observed Data
tab [Sections 10.21 and 13.8].

a. On the Physical tab, a tree appears in the left panel of the
window. Initially, two branches of the tree are shown: Pool and
Dam. The Pool reflects characteristics of the reservoir storage while
the Dam reflects the reservoir dam.

_‘-i_ Reservoir Editor E]
Reservoir  Edit  Pool
Reservair iMyRESOnE v | Description | al E]E] 1 0f1 [E][E]
| Physical igperations Observed Data |
Fa\ ngREOne MyResOne-Pool
Fool
7 Dam at My Main River @) Linear Interpolation ) Conic Interpolation [ |
Elevation Storage Area
(f (ac-t {acre)

Elev {undef)
1

T T T T T 17T
20 40 6.0 80100
Stor {undef)

Elev {undef)
1

T T T T T 17T
20 40 6.0 80100
Area fundef)

Figure 19 — Reservoir Editor, Pool Data

e Enter Pool Properties. Click on Pool to enter the Elevation
vs. Storage vs. Area data (as shown in Figure 19). At least two
rows are required for Elevation, Storage and Area data,
with values increasing down the columns (no duplicate values).
The maximum elevation should not exceed the Elevation at
top of dam, which is input when Dam is selected. Pool losses
can be specified by right-clicking on Pool and selecting Add
Pool Evaporation and/or Add Pool Seepage
[Sections 10.2 through 10.4 and 10.14].
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Enter Dam Properties. Click on Dam in the reservoir tree.
The data area to the right of the reservoir tree will change to
allow you to enter the data needed to define the dam /Sections
10.5 and 10.6]. Before proceeding, take a look at the name of
the dam. The name is probably something like “Dam at My
Main River.” This is the default name the program gives to the
dam. It identifies the dam based on the name of the underlying
stream upon which the dam was placed. This enables the
program to uniquely identify more than one dam within a
reservoir. It is a rare case when a reservoir has more than one
dam, so feel free to rename the dam by right-clicking on the
dam name and selecting Rename (as shown in Figure 20).
One suggestion is to name it Dam by removing the stream
name. Another possibility is to name the dam by its actual
name (many reservoirs have a name for the pool and a different
name for the dam; ResSim provides the ability to name each
part individually).

i Reserwvoir Editor
Reservoir  Edit  Dam

Reservoir [MyResOne +| Deseription | O W] 1011 [])(m)
| Prwsical | operations | Observed Data

A MyResOne | miyResOne-Dam at My Main River

Pool
R Darn at My Main Rivar
Add Tailwater Elevation :
Add Leakage Length at top of dam ()

Elevation attop of dam (@ |

Add Controlled Outlet

Add Uncontrolled Outlet [ _
add Outlet Group | Elevation Controlled | Uncontrolled Tatal
Add Power Plant (ft (cfs) (cfs) (cfs)
Add Pump |

Composite Release Capacity

Pulse Flow Options

Elevation

20 B0 10C
Flowy
{cfs)

Figure 20 — Reservoir Editor, Rename Dam

Enter the elevation and length of the dam in the relevant fields.
The composite release capacity table is not editable. This table
is informational and will be filled automatically as you add
outlets to the dam.
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e Add Outlets. Physical Outlets can be added to the Dam by
right-clicking on the Dam. Figure 20 illustrates the dam’s
shortcut menu. Select Controlled Outlet to add a gate or
other control structure to the dam /Sections 10.8 and 10.16].
You can rename the outlet by right-clicking on the outlet and
selecting Rename.

A simple controlled outlet can be defined by entering a
maximum release capacity curve for the outlet. If a more
detailed outlet is desired, press the Edit Gate Settings
button. The Gate Settings Editor will allow you to define a set
of gate openings with Elevation vs. Maximum Capacity (flow)
data. When finished, the release capacity table will show
several more columns (as shown in Figure 21), one for each
gate opening in the set you defined.

% Reservoir Editor @

Reservoir Edit  Outlet
ResewolrinResOne | Description | @] (][] 1 ot 1 [](w]
| Physical | Operations | Obssrved Data
MyResOne MyResOne-Dam-MainGates
Number of Gates of this type ‘ 1
Elevation Max Capacity (cfs)
@ FishLadder i For Gate Setting ()
1.00 .00 a.00 11.00 15.00 './
540.0 0.0 0.0 0.0 1) 0.0 A s
495.0 1700 500.0 500.0 500.0 400.0
6000 250.0 1030.0 1350.0 1350.0 1350.0
605.0 3100 1400.0 2200.0 24400 2500.0
610.0 360.0 1680.0 2800.0 32900 3560.0
615.0 4100 1930.0 3390.0 39400 4460.0
620.0 460.0 2130.0 3730.0 4510.0 52500 BED =t
6250 500.0 2310.0 4110.0 5000.0 5020.0 D 4000 E0DD 12000
630.0 530.0 24800 4450.0 5450.0 64800 Capacity (cfs)
B35.0 570.0 2650.0 4770.0 5850.0 B980.0
640.0 600.0 28100 5070.0 6260.0 74700
645.0 620.0 2950.0 5360.0 6630.0 79100
B50.0 640.0 3100.0 5630.0 B980.0 8340.0
655.0 660.0 32400 5800.0 73200 8730.0 —
BE0.0 620.0 33800 6160.0 7640.0 91200
6650 6a0.0 3500.0 6400.0 79300 94800
G70.0 To00.0 3630.0 6E30.0 82200 9830.0
675.0 705.0 3750.0 6850.0 8500.0 10160.0
620.0 rog.0 2ee0.0 7070.0 avi0n.0 10500.0
683.0 710.0 3850.0 7200.0 8900.0 10B50.0
v
Physical Limitations:
Max Rate of Increase (cfs/hn I 2000 |
Max Rate of Decrease (cfsin) | 4000 | EdiCatenetns
-

Figure 21 — Reservoir Editor, Gated Outlet

24 April 2007



HEC-ResSim Quick Start Guide

Select Uncontrolled Outlet to add an ungated emergency
spillway to the dam /Sections 10.9 and 10.18]. For an
Uncontrolled Outlet, the spillway length and elevation are
entered along with either a Weir Coefficient or an
Elevation vs. Outflow relationship. The spillway elevation
must be at or below the Elevation at top of dam and above
the minimum storage elevation. Figure 22 shows the window
for entering data for an Uncontrolled Outlet.

?Reservuir Editor @
Reservair Edit  Spillway
Resenvoir [yResOne +| Description | 0] [W](a] 1 or1]m](m]
| Physical | gperations | Ohserved Data
A MVR:SOI"E MyResOne-Dam-Uncontrolled Spillway
ool
= 57 Dam Cutlet Elevation (f) 1 |
4 MainGates 5
T || O Weir Coef. ‘ |
FishLaddi
* FishLadder Length (1 ‘ |
(@ Elevation ws. Outflow
| [:@ Elevation (fy Cutflow (cfs) J
G57.0 0.0/A 625
6580 2500.0 620
650.0 650000 | & g7sd
AR0.0 120000 =
66510 160000, | £ 570
663.0 290000] || % 985
B65.0 26000.0) | W 860
BRT.0 640000 BSST—T—T T T 7
6RO 85000.0 o 140000 300000
6700 960000 Outflow (cfe)
6720 1200000
G750 1580000
676.0 1720000]
6780 2000000
B79.0 2160000
GB0.0 2320000
G230 2800000
~
|

Figure 22 — Reservoir Editor, Uncontrolled Outlet (Spillway)

e In addition to Controlled and Uncontrolled Outlets, the
following components can also be added to the Dam:

Leakage /Sections 10.6 and 10.15],
Outlet Group /[Section 10.7],
Tailwater Elevation /Sections 10.10 and 10.19] ,
Power Plant /Section 10.8.2 and 10.17], and
Pump /Section 10.8.3 and 10.18].
¢ In addition to adding physical components to the Dam, there is

an advanced option for specifying Pulse Flow Options
[Section 10.22].
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b. When the Operations tab is initially chosen, a screen similar to
Figure 23 will appear. A new operation data set must be created
before operations data can be entered /Section 11.2.1].

% Reservoir Editor E|
Reservoir  Edit  Operations
Resenoir pyResOne R ~ Description [m] @@_1_9_[1_[@@
Physical| Qperations | Observed Data
Operation Set w | Description Q
Zone-Ruies
Storage Zone | Description ]
[ Date Top Elevation {) |

[ Allow Multi-year Seasonal Data
Starting Year

[] Define Zone with Time-Series

3

” Cancel I

”

Cancel

Figure 23 — New Operation Set

Create an Operation Set. Select New from the Operations
menu and give the new operation set a name (as illustrated in

Figure 23). An Operation Set is the operation plan or scheme
upon which a reservoir bases its decisions regarding how much
water to release at each time step of a simulation run /Section 11.2].

Operation Zones. Once an Operation Set is created, then a set of
“default” reservoir zones is generated: Flood Control,
Conservation, and Inactive. Additional zones can be added by

selecting New from the Zone menu. Top of zone curves must be

entered, as no default values are available /Section 11.3].

Operation Rules. To add
a rule to a zone, highlight
the appropriate zone and
select New from the Rule
menu. In the new rule
window (Figure 24), enter
a name for the rule, then
select the pool, dam, outlet,

or outlet group for which the rule will apply (Operates Release

Rule Name: [T |
Operates Release Fram: |wyResOne ¥/
Rule Type: |Releaze Function v

Figure 24 — New Operating Rule

From), then select the rule type from the Rule Type list, and then
click OK /[Sections 11.4 and 11.5].
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Rule types differ depending on where the rule is applied (pool, dam, or
outlet) /Section 11.5]. The rules that apply to the Reservoir Pool, are
typically relevant to Storage or Elevation, whereas the rules that apply to a
Dam or an Outlet are relevant to Flow.

Rules for the Reservoir Pool include the following:

*

* Release Function, Maximum, Minimum or Specified Release as

a function of Date, Date and Time, Model Variable, or External

Variable /Section 11.5.3].

Downstream Control Function, Minimum or Maximum Flow

or Stage target or constraint (at a downstream location) as a

function of Date, Date and Time, Model Variable, or External

Variable /Section 11.5.4].

% Tandem Operation, Release based on balancing pool with a
downstream reservoir /Section 11.5.5].

% Induced Surcharge, Special flood control operation using gate
regulation parameters /Section 11.5.6].

% Flow Rate of Change Limit, Allowable change when increasing
or decreasing release values /Section 11.5.7].

% Elev Rate of Change Limit, Allowable change when increasing or
decreasing pool elevation values /Section 11.5.8].

% Script, User-defined scripting available that dramatically increases the

flexibility of reservoir operations. /Section 11.5.11].

X/

X/
L %4

Rules for the Reservoir Dam, Controlled Outlets, Outlet Groups, and
Diverted Outlets include the following:

R

% Release Function, Maximum, Minimum or Specified Release as
a function of Date, Date and Time, Model Variable, or External
Variable /Section 11.5.3].

% Flow Rate of Change Limit, Allowable change when increasing
or decreasing release values /Section 11.5.7].

% Script, User-defined scripting available that dramatically increases the

flexibility of reservoir operations. /Section 11.5.11].

Rules for Power Plant include the following:

*

% Release Function, Maximum, Minimum or Specified Release as
a function of Date, Date and Time, Model Variable, or External
Variable /Section 11.5.3].
% Flow Rate of Change Limit, Allowable change when increasing
or decreasing release values /Section 11.5.7].
% Hydropower - Schedule, Monthly Firm Energy Requirements
(specified as Monthly MWH or % Plant Factor) with optional Daily and
Hourly distributions /Section 11.5.9.1].
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X/
X4

L)

Hydropower - System Schedule, Monthly Firm Energy
Requirements (specified as Monthly MWH or % Plant Factor) with
optional Daily and Hourly distributions /Section 11.5.9.4].
Hydropower - Time Series Schedule, Energy Requirement as defined
by user-supplied time-series data /Section 11.5.9.2].

» Hydropower -Power Guide Curve, Energy Requirement
(expressed as % Plant Factor) is dependent on the available power
storage. Optional Daily and Hourly distributions can be specified
[Section 11.5.9.3].

Script, User-defined scripting available that dramatically increases
the flexibility of reservoir operations. /Section 11.5.11].

X/
X4

L)

DS

X/

%

Rules for Pumps include the following single rule:

% Pump Schedule, Pumpback storage operation using user defined
schedule /Section 11.5.10].

Depending on the rule type, you will need to
enter data to define the rule. A screen will

. . gl Flood Cantrol Pool
open in the editor to allow you to enter the @ MaxcPs5_3000
required data for each rule. The rules and B MaxCP7?_9000
storage zones are displayed in a tree on the left — |w
side of the window (as shown in Figure 25). & MinResB_50

Zone-Rules

A WQ Optimal Pool

ane a mle has been defined, it can be . @ MinCP7_100

included in more than one zone by selecting @ MinResB_50

Use Existing from the Rule menu. # WG Lower Pool
@ MinCP7_75

Similarly, a rule can be removed from a zone
by selecting Remove from Zone. A rule
can be deleted from the operation set by
selecting Delete. However, when a rule is
Deleted, then it is no longer available to any of
the zones; therefore, caution should be used
when actually deleting a rule.

A inactive Pool

When finished entering data for a reservoir,
click OK. To edit a different reservoir without ~ Figure 25 —

exiting the reservoir editor, click Apply and Zones and Rules Panel
select another reservoir from the Reservoir

list.
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c. The Observed Data tab is used to indicate that observed data is
available for comparison purposes /Section 10.21]. 1f the Observed
box is “checked” in the table (as shown in Figure 26), then there will
be a corresponding entry in the Observed Time-Series mapping table
when an Alternative is created /Section 13.8].

_"i: Reservoir Editor E]

Reservoir  Edit

Reservoir [=EEE (e

~ | Description | Most Upstream Reservair on Bonner creek (| [1][@] 2 0f21@@

Select Locations that display Observed data in output reports and plots

Location Variahle Obzerved

Resernir A-Poaol Eley [v]
Reserair &-Pool Stor ]
Resermir A-Fool Flowe-I1

Resaroir A&-Foal Flow-IM MET []
Reservair A-Poal Flowe-EVAP ]
Reservoir A-Pool Flow-SEEPAGE ]
Reservair A-Poal Area ]
Resernir A-Pool Flow-0UT ]
Reservoir A-Dam at Bonner Creek Tailwater | Flow []
Reservoir A-Dam at Bonner Creek L&D Flow

Reservoir A-Controlled Outlet Flow []
Reservoir A-Uncontrolled Spillway Flaw ]

Figure 26 — Observed Data Tab

5. Save the Reservoir’s Physical and Operations data, Junction
information, Routing criteria, etc.. From the Network menu select
Save. Itisagood idea to do this frequently.
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Define Alternatives

Create an Alternative. An Alternative consists of a Reservoir
Network, an Operation Set for each reservoir in the network, a definition
of initial conditions, and a mapping all time-series records to identified
local inflows, etc. To create an alternative:

1. From the Alternative menu (in the Reservoir Network EmEDE
module) select Edit /Section 13.2].

Edit...

2. Inthe Alternative editor, ensure that the appropriate Configuration
name is displayed from the list of available configurations. Then,
from the Alternative menu, select New (as shown in Figure 27).

® ResSim Alternative Editor

Alkernative

m

rdizonfig

Save bs..,

Close

Description

¥ New Alternative

Marme: |

Description: |

Reservoir Metwork |

Marne: ||
Description: | [J
Metwork: |NnrmaINetwnrk2 i

Resermair System

Ok Cancel

Reservair

Operation Set

Figure 27 — Alternative Editor, Create New Alternative

3. Inthe New Alternative editor, enter a name for the Alternative in the
Name box and a description in the Description box. Select a
Reservoir Network from the list and click OK.

All of the relevant fields in the Alternative Editor will become active

[Section 13.3].
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4. 1Inthe Alternative editor, select an Alternative. On the Operations
tab, select an Operation Set for each reservoir /Section 13.4]. This
can be accomplished in the Operation Set column by selecting (for
each Reservoir) the operation set from the list that appears, as shown

in Figure 28.
_‘-i ResSim Alternative Editor @
Alternative
Configuration: |Standard00nﬂg vl
Marme Description
StandMorm2
Alt2
Mame: | TypOps
Description: | Typical Operations, StandardConfly, MormalMet? m]

Reservoir Metwark |NnrmaINeTWDrk2 |

Operations | Lookback || Time-Series | Observed Data

Reservair System Storage Balance
Resarvair Operation Set
Reserair &

Reseroir B

Figure 28 — Alternative Editor, Operations Tab

5. Onthe Lookback tab /Section 13.6], select the initial conditions
Type (Times-Series or Constant) from the list for each Location
listed, as shown in Figure 29. This is similar to selecting the operation
set per reservoir. For Variables defined as Constants, enter a
constant Value for the Elevation or Release.

Opetations | Lookback | Time-Seies | Ohserved Data

Laocation Variahle Type Default Value
Reservoir B-Fool Lookback Elevation  |Constant hd 14300
Reservoir B-Fool Lookback Storage Computed hd
Reserair B-Caontrolled Outlet Lookback Release  |Constant @ 155.0
Resenoir B-Uncantralled Spillway  |Lookback Spill Constant - 0.0
Reservoir A-Pool Lookback Elevation  |Constant hd 1450.0
Reservoir A-Poal Lookback Storage Computed hd
Reserair A-Controlled Outlet Lookback Release  |Constant d 122.0
Reseroir A-Uncontralled Spillway — |Lookback Spill Constant e 0.0

Time-Seties

Figure 29 — Alternative Editor, Lookback Tab
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6. On the Time-Series tab /Section 13.7]select a row in the time-series

mapping table (as shown in Figure 30). Each row in the table
represents a required input for a local flow location (specified in the
Local Flow tab within the Junction editor), an element/parameter you
have defined on the Lookback tab as Time Series, or a Time Series
that is referenced in the Operation rules. To attach a time-series record
to the selected location, press the Select DSS Path button.

Operations | Lookback| Time-Series | observed Data

Yariahle D55 File PartA PartB Part C Part E
A Known Flow
B Known Flow
Known Flow
Known Flow
Known Flow
Known Flow
Known Flow
Known Flow
CPB{CPTH.40) Known Flow
CPB(CP9XY) Known Flow
CP13 Known Flow
Resenoir B-Fool Lookback Elevation
Reseroir B-Controlled Qutlet |Lookback Release
Resenoir A-Pool Lookback Elevation
Resenoir A-Controlled Outlet |Lookback Release

Gelect DES Path...

Figure 30 — Alternative Editor, Time-Series Mapping

The DSS path selector window will appear as shown in Figure 31.
Open a DSS file, use the parts filters to organize the catalog listing,
and select a record. To get the selected record to map back to the
alternative editor, press the button labeled Set Pathname.

Hayes0ct99. dss - Select Time Series Path |Z||E|[z|
File Edit Wiew Display Help

rAVES VN

File Name: |G:IHEC Data\HEC-ResSim_v3.Mhase\HayesBasinmsharediHayesOctd9.dss
Pathhames Shown: 10 Pathnames Selected: 1 Pathnames in File: 14 File Size: 699 KB

Search A v G FLOWY ¥ E ~
By Parts: [: (D | F.|Z2B M
Mumber | Apart Bpat ... Spart D partirange Epart Fpart

3 KEYSER HW FLOWY 01 0CT1999 THOUR 2B e’
4 LUKE L FLOWY 01 0CT1999 THOUR 2B
5 MY LOC FLOWY 01 0CT1999 THOUR 2B
5] PIMTO LOC FLCWY 010CT1999 1HCOUR 2B

01 9
o ] o

I 9 WILLS CH LOC FLOWY 010CT1999 THOUR 2B hd

SRANDOLPH INFLOW JCTIFLCAWY

OCT1999/ HOURZES

[ select | [ De-select | [ ClearSelections | [ et Pathname

Mo tirme window set. |Replace the list with the selected pathnames |

Figure 31 — DSS Time-Series Record Selector

On the Observed Data tab /Section 13.8], using the same procedure
as the Time-Series mapping described above, select optional time-
series records for use in comparing with computed results.
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Perform a Simulation

Once the reservoir system data are entered, the model can be configured
for a Simulation. From the Module list, select Simulation. Model
elements of a Reservoir Network will not display in the map region until a
Simulation is created or opened and an Alternative has been made active.

1. Create/Open a Simulation. To create a Simulation, from the
Simulation menu select New. The window illustrated in Figure 32
will open /Sections 14.2 and 14.3].

? Simulation Editor @

MName 2005.12.22-1DDD|
Description )
Simulation Times
Start Date 22Dec2005() | Time 1000
Lookback Date 22[)902005@ Time 1000
End Date 22Dec2005(.] | Time 1000
Time Step 1 Haour E¥3
Alternatives
Select Mame Description
O StandMarm?
¥ TypOps Typical Operations, StandardConfig, MarmalMet2
O Alt2
I Ok ] [ Cancel

Figure 32 — Simulation Editor

e Enter a Start Date & Time, a Lookback Date & Time, and an
End Date & Time.

e Enter a name for the Simulation in the Name box. A name is
generated by default based on the time window. You can use the
default name or you can wipe it out and put in a name that is more
meaningful to you. You can also enter a Simulation Description.

e Seclect a Time Step from the list.

e Seclect one or more applicable Alternatives for the Simulation
and click OK.

2. Set Alternative to be Active. In the “tree list” of alternatives for
the simulation (on the right side of the screen), right-click on the
desired alternative and select Set as Active. At this point, the model
elements of the Reservoir Network will be displayed in the map region
reflecting the active (notice bolded name) alternative /Section 14.4.1].
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3.

4,

Compute. After all data and parameters have been input as desired,
click on the Compute “Name of Alternative” button in the control
panel of the Simulation Module’s main window | Compute Typops |
to perform the computations /Section 14.4.2]. *

A compute window will appear showing status messages and program
progress. When the computation is finished, a "Compute Complete"
message will appear and the status bar will read 100%. Click Close
to close this window. Note: You can stop the compute process before
the compute is complete by clicking on Stop Compute.

View Results. Model results can be reviewed from three different
approaches /Section 14.5 and Appendices E & F].

e Plots. On the model schematic youcan @ =~ rewn
right-click on a model element to get a
menu list. Included on the list will be - =
one or more plot options. Select the _‘m tbliictid
option by clicking on it. The default plot P oz tors

will display. The plotted results can be s ke ’

tabulated by selecting Tabulate from

the plot’s File menu /Section 14.5.2].

Release Decision Report

e Summary Reports. From the
Reports menu in the Simulation
module, there is a list of Summary
Reports for the model simulation
[Section 14.5.3]. The Reservoir,
Flow, Power, Gates, and Stage
reports provide Average, Maximum
and Minimum values for the
simulation. The Release
Decision summary report provides
the current zone and limiting
operating rule for each reservoir for
all time periods of the simulation.

o DSS Viewer. When HEC-DSSVue is Rrictasmio votan
selected from the Tools menu, a DSS file ... ... . ‘==
is opened that contains the results of the
simulation /Section 14.8 and Appendix E].
A list of pathnames is provided but a
screened list can be obtained by selecting a
pathname part from the lists in the
Search by Parts section of the window.
To select records to be displayed, highlight the pathnames and
click on the Select button. After one or more records are
selected, the buttons for plot and tabulate become active. Click
either button to generate the associated output.
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5. Spec|fy Overrides. Once you have ETEE N Alternative Reports  Tools
completed a simulation, you can override Hew...
model results by specifying either reservoir ;’:i:;;n R
the Elevation Target or Releases (per outlet) -
or Capacity Factors (per outlet) for some =
(or all) of the time steps /Section 14.6.3]. Savs
ResSim will use the values you specify for Delete...
Elevation Target and Release Overrides, Irfo...
within the physical limits of the reservoir overrides b ;:;';Ops
(i.e., the physical rate-of-change, the release

capacity and the amount of water available in the reservoir may
preclude ResSim from using your override values). To specify the
override values, select Release Overrides from the Simulation
menu in the Simulation module for the desired alternative; or, you can
select the Overrides button by right-clicking on the “Active
Alternative” and selecting Edit — ResSim from the shortcut menu
and then click on the Overrides button. The Overrides Editor will

open (Figure 33).
Reservoir e
| Elevation Target | Release | Capacity
Date Time Elevation Target ity | l T - ]
200t H6G 0700 1,450, 00| A nspecity
200ct! 988 0800 1,450.04] ’ Unspecify Al |
200ct 994 0900 1,450, 33
Z00cH 9949 1000 1,451,258 [ Impart. ]
200ct 994 1100 1,453, 28
200ct1994 1200 1,456.95
200ct 994 1300 1,461,859
200ct] 494 1400 1,467, 16 1480
200ct 994 1500 1,471.57 14754
200ct1994 1600 1,474.66
200ct 994 1700 1,475.32 1470
200ct1 994 1800 1,475.09
200ct 994 1900 1,474.39) 1465
200ct1 994 2000 1,473. 49 =)
200ct 994 2100 1,472.65 & 14807
200ct1 994 2200 1,472.00 w
200ct1 958 2300 1,471.47 14557
210ct1994 0000 1,471.03 .
210ct1 994 0100 1,470, 65
210ct1994 0200 1,470, 32 paa5——+ 1 | 1 |
210ct1 9949 0300 1,470.03 1200 0000 1200
210ct1994 0400 1,469, 83 300¢t1989 | 210¢t 599
710 994 M50 1.4p9. fzl Y

Figure 33 — Overrides Editor

To specify override values for the “selected reservoir” (see Reservoir
list at top of Overrides editor), do the following:
o Sclect either the Elevation Target or Release or
Capacity overrides tab.
e To revise a single value, double-click in the cell you want to
revise and enter the new value.
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To revise multiple adjacent values: Elewation Target (f)

1. Point and click on the first cell,
then drag your mouse or shift-click
to highlight the cells to be revised.

2. Right-click on the highlighted Select Al &

cells, and select Fill from the Print
ShOI’tCll'[ menu. The Table Fill Frint Preview:. ..
Options dialog box will open.

3. Select the appropriate fill option in [ TR X
the Table Fill Options dialog box, — -
then click OK. The revised values
will reflect the fill option you © RepeatFll
selected. Also, the color of the OsddConstant ||
revised values changes from black | ©mutiple Factor ||
to blue and the mini-plot shows [ ox [ came |

the revised values as a red line.

For those time steps where you do not specify override values,
ResSim uses the reservoir rules to determine the reservoir
release values. After running a simulation using your override
values, you may decide to no longer use some, or all, of your
override values. If so, you can use the Unspecify and
Unspecify All buttons to indicate that you want ResSim to
determine the release values during the next compute.

R/

« Use the Unspecify button when you want release values
to be based on the reservoir rules for some of the override
values you have specified. Highlight the cells where you
have specified override values (they are green in the
Release Overrides table), then press the Unspecify
button.

X/
°e

Use the Unspecify All button when you want all of the
release values to be based on the reservoir rules and not
have any overrides specified.

Use the Import button when you want to use a Time Series of
override values. The Import Overrides Time Series dialog
box will open, which functions exactly like the Select Time
Series Path dialog box used to select time-series records for
an Alternative.
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6. Manage Simulation Data. There are two operations involved in
managing Simulation data /Sect/ion 14.7]. You can save your data to
the base directory to make it available for other Simulations, and you
can replace data in a Simulation for a specific Alternative with data
from the base directory. See Appendix A of the ResSim User’s
Manual for an overview of the ResSim directory structure, including a
discussion of the base and simulation directories.

Save Data to the Base Directory.
When you edit model data from the
Simulation Module, your changes
apply only to an individual
Alternative that is saved in your
Simulation directory. If you want
your changes to be available for
subsequent Simulations, you will
need to save the data back to the
Base directory /Section 14.7.1]. This
will make your changes to physical
and operational data available in the
Reservoir Network Module.

Replace Data from the Base
Directory. If, while editing data in
the Simulation Module, you need to
revert to the original Alternative
data from the Network Module, you
can replace the changed data in your
Simulation directory with data from
the Base directory. /Section 14.7.2]
This will make your original data
(from the Reservoir Network
Module) available in the Simulation

Simulation Control

Sitnulation: 20 Qct 1999, 0600
Lookback: 18 Qct 19948 0200
End: 21 Oct 1999, 2100

9 2000t 999-0600

|:| Alt2

EITypOps|
TypOps----0
Compuke
Edit »
Set As InActive
Mew Trial, .,

Replace From Base Directory..,

Save ko Base Directory. .,

Mowve Up

Simulation Control

Simulation: 20 Oct 1999, 0600
Lookback: 18 Oct 1999, 0200
End: 21 Oct 1898, 2100

_4 200ct1999-0600

] Atz
EITypOps|
Typops----0
Cornpute
Edit 4
Set Az InAckive
Mew Trial...

Replace From Base Directory. ..

Module, OVGI'WI'itiIlg any changes Save to Base Directary. .. k
you made to the selected alternative Move Up
within the Simulation Module.
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